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DEAR READER ...

Yes, I hang my head in shame. I allowed the holiday laziness to grip me a little too early, and 

this edition of Dev.Mag was terribly late. No extra eggnog for me this year, it seems. The good 

news, however, is that I can quickly distract you with two interesting facts: firstly, it’s the 

Christmas season, and that’s as big in the gaming world as it is with any conglomerate which 

preys on the festive notions that most people have at this time of year. We’ve even prepped this 

issue in a small way to reflect some festive cheer — check out the Tailpiece for more info.

Fact number two is the big one for indie gamers everywhere: Aquaria is out. We’ve got a lovely 

little interview with them this issue, and after playing the demo we’ve decided that the game 

definitely merits a review in Issue 20. Some feel that the price tag of the full version is a little 

steep, but I’m in the camp which believes that if people can fork out USD $30 for some of the 

mainstream flops that hit our shelves, they can certainly make the same investment for the win-

ner of the 2007 IGF grand prize.

From what I’ve seen, Derek Yu and Alec Holowka are a fantastically down-to-earth pair of guys 

who truly deserve to be paid off for their hard work on such an amazing product. Best of luck to 

them in their future endeavours — I’m sure that Aquaria is going to be a massive success.

My own shameless bias aside (I’m quite awful, really), it’s thrilling to see what’s happening to 

indie games nowadays. Projects of an incredibly high standard are cropping up everywhere, 

and comparing the indie games of today to those of, say, five years ago reveals some startling 

changes. If you need convincing, be sure to check out this year’s lineup of IGF finalists — our 

From the Net section has more details.

For now, season’s greetings and enjoy the holiday! We take our end-of-year hiatus now and will 

return in February.

RODAIN “NANDREW” JOUBERT
EDITOR

So what if Bookworm Adventures isn’t the 

newest of new games? It’s still shamelessly 

fun, and a few of us jumped onto the 

bandwagon just recently after our dep-ed 

played it through and reported that it 

wasn’t just an educational kiddie’s title 

after all. He also managed to spell the 

word“vivification”. The git. Find the game 

over at http://www.popcap.com/
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AQUARIA RELEASED

http://www.bit-blot.com/

Hey. Hey. Aquaria. Out now. Get it. Get it. Now. 

Seriously. Now. We’ve just finished playing the demo 

here, and it already looks like one of the most awe-

some indie games that we’ve ever gotten our grubby 

little paws on. Needless to say, we’ll be grabbing the 

full version as soon as possible. We’ll buy it twice, 

even. In fact, we’d pay money just to play the demo 

again. It’s really that good. Expect a full review once 

we’ve got the whole game to mess around with, and 

check out this edition’s feature for an interview with 

the creators of this masterpiece.

IGF FINALISTS ANNOUNCED

http://igf.com/02finalists.html

The next set of hopefuls in the Independent Games 

Festival lineup has been announced, ready for the 2008 

summit in February. What does that mean for us? Well, 

a bunch of high-quality releases which are likely to titil-

late even the most jaded of indie gamers. The lineup 

has a strong presence of audio-based gameplay (includ-

ing one game which utilises a Guitar Hero controller 

for platforming action), as well as one or two surpris-

ing entries from the Game Maker front. Some of the 

games already have full (free) releases available for 

download, while others have made playable demos.

ELECTRONIC NINJA ROPE? DO GO ON ...

http://www.gamedev.net/community/forums/topic.asp?topic_id=473549

Whilst stumbling about on GD.Net, 

one of the loyal Game.Dev community 

members came across a game tenta-

tively titled Electropy and shared his 

findings with the rest of the group. The 

game is comparable to playing Elas-

tomania with an electric ninja rope, 

though it also includes a collection of 

powerups and far better graphics. It’s 

also rather fun. Check out the link for 

images, a description of the game and 

a 33 MB demo.
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XNA GAME STUDIO 2.0

http://creators.xna.com/

Get ready to rumble with the newest release in the XNA devel-

opment line. Changes include a wider support for Visual Studio 

2005 products, advanced debugging features, a project upgrade 

wizard (to convert old XNA games to the new format) and some 

major advancements in multiplayer support. A Net Rumble 

Starter Kit is already 

available for people who 

want to experiment with 

net code by modifying a 

pre-built XNA game.

JONATHAN BLOW ON THE “WoW DRUG”

http://www.gamasutra.com/php-bin/news_index.php?story=16392

Gamasutra never fails to bring us people who have interesting and 

new perspectives on game development. Now, they deliver us a 

page of Jonathan Blow, the 2006 IGF Design Innovation award win-

ner and creator of the game Braid. And boy, does he have a lot to 

say about modern game design. A small essay on player motivation, 

the purpose of gaming, and common misconceptions provides some 

interesting reading for those keen on understanding game design 

better.

I’M O.K ... SORT OF

http://www.derekyu.com/

Derek Yu is one of the blokes behind the much-lauded Aquaria. A little bit of 

investigation shows that he’s behind a few other games as well, including the 

massively popular (and somewhat controversial) ultra-violent platformer “I’m 

O.K”, the tongue-in-cheek reply to anti-videogame attorney Jack Thompson’s 

“modest videogame proposal”. 

If you haven’t played it yet (or 

are looking for a bit of nostal-

gia to go along with Aquaria’s 

release) check out Yu’s website 

for the download. Be warned, 

though – this one’s definitely not 

for the kids and shouldn’t be 

played if you’re squeamish.
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GEARING UP FOR INSTANTACTION

http://blog.instantaction.com/

We’re shivering in our booties about this one. 

Described as “something like XBLA for the PC”, 

InstantAction is slated to be the platform which 

finally allows web-based gaming to catch up to its 

peers, with content that downloads as you play 

and apparently a “near-console quality” potential. 

A GarageGames innovation, InstantAction’s launch 

is geared for January and will include both free 

and paid-for products. There’s also a competition 

mentioned on the blog for those interested in 

developing for the platform.

SOUTH AFRICA “MATH”STERMINDING ANOTHER TITLE

http://lms.mindset.co.za/mediawiki/index.php/Mathstermind

Hot on the heels of local production Cartesian Chaos is the news that another entry from 

last year’s Game.Dev educational games competition, currently going by the name of 

Mathstermind, is in the works for the mobile platform. Although it’s still early days (the 

only thing that we’ve had a chance to see are a few dang control prototypes for assess-

ment purposes), a description of the game is up on the Mindset wiki and Dev.Mag may 

soon be graced with a project diary showing readers how a South African group goes 

about publishing a mobile game. Watch this spot!

HOLIDAY GAMES — MORE WANTED

http://www.gamasutra.com/view/feature/3183/persuasive_games_the_holly_and_.php

Another offering from Gamasutra this month is a feature 

which basically looks at holiday themes within games and 

nags us for more. A quick history of seasonal tributes in 

some of the more popular games – from Super Mario to the 

Sims – is given, and several examples of festive mods and 

even changes in game-

play based on the time 

of year are examined. 

Not a thoroughly deep 

read, but it’s nice to 

browse through if you’re 

in the seasonal spirit.
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MASTERS OF AN
UNDERWATER FANTASY

AN INTERVIEW WITH THE CREATORS OF AQUARIA

by Simon “Tr00jg” de la Rouviere

Bit Blot, comprising of Alec Holowka 

and Derek Yu, is the group which 

masterminded the winner of IGF’s 

2007 Grand Prize, Aquaria. Since its release 

on 7 December, Aquaria has quickly consoli-

dated its reputation as a high-quality product 

and has subsequently raised the bar for indie 

games everywhere. Shortly before the official 

release, Dev.Mag had a chance to speak to 

the guys about Bit-Blot and Aquaria.

 

Firstly tell us more about yourself. Who are 

you and where do you come from?  

 

ALEC: I’m Alec! I grew up in Winnipeg, 

Canada which explains why I have terribly 

low self-esteem. My dad was the guy who 

first got me into making games (he thought it 

would be more creative/productive than just 

playing games all day!) with a book called 

“BASIC Fun” when I was eight years old. Ever 

since then, I’ve been writing music, making 

games and taking names. 

 

DEREK: I’m Derek. I was born in California, 

in the United States of America. Needless to 

say, I always carry at least a dozen guns on 

me at any given time. Hey, it’s a dangerous 

world out there! 

What is it like collaborating on a game across 

the Internet? Don’t you sometimes get lost in 

communication? 

 

ALEC: Sometimes it can get confusing, but 

overall it’s worked out pretty well. We’ve 

also worked together in person a number of 

times, so we now have a better understand-

ing of where the other person is coming 

from. 

 

DEREK: There was definitely some difficulty 

in the beginning ... for the most part Alec 

and I have similar ideas about how to do 

things, but for times when we don’t, it’s 

much easier to com-

municate over the 

phone or in person. I 

wouldn’t recommend 

trying it unless you trust who you’re working 

with completely! That said, it does work out 

pretty well for us. 

 

Tell us briefly what your latest project, 

Aquaria, is all about.  

 

ALEC: The cool thing about Aquaria’s story 

is that its layered; there’s a surface story 

that is engaging the player, but there is also 
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a deeper story - and beyond that there are 

fundamental themes about  

relationships and creation. I’m hoping that 

players will be able to fully immerse them-

selves in the story and the exploration and 

just get lost in the world we’ve created! 

 

DEREK: We worked really hard to make sure 

that Aquaria was a “complete” experience. 

That is, every part of the game – graphics, 

sound, level design, controls – works together 

to ensure that the player is always engaged. 

The mouse-only control scheme came from 

that line of thinking ... as did our choice to 

go with voice acting instead of text-based 

dialogue. I think one of the unique things 

about this game is how it marries these vari-

ous concepts. We wanted everything to be 

very elegant. But the short answer is that 

Aquaria is a massive underwater fantasy 

world. As the player you get to explore it and 

uncover its secrets.

 

How did you guys decide you were going col-

laborate on something like Aquaria?  

 

ALEC: I was doing some music for Derek’s 

game “I’m OK”, and we just started talking 

about games and game ideas, and real-

ized that it would be fun to make a game 

together! 

 

DEREK: Yeah, it was pretty serendipitous, I 

must say! 

 

What are your roles in Aquaria? 

 

ALEC: I do programming and music. We work 

on the design of the game together. 

 

DEREK: I do the graphics and most of the 

level building! 

How long has Aquaria been in development?  

 

ALEC: Since I first showed my ancient proto-

type of the idea to Derek it’s been just over 

two years. 

 

Where did Aquaria’s inspiration come 

from? 

 

ALEC: For me it was mainly games 

like Final Fantasy VI - games where  

you explore a fantastical world while 

having adventures. Games with worlds 

you’d want to travel to in person one day! 

:) I was also inspired by Blood Omen: Legacy 

of Kain, mainly because I loved the atmos-

phere and the way it used voice overs. 

 

DEREK: I’ve always liked games where you 

get to explore and find interesting places and 

things. Eternal Daughter was an homage to 

my favorite games as kid - Zelda, Metroid, 

and Castlevania. There was a lot about that 

game that I thought could have been im-

proved, and so I think you can see some of it 

in Aquaria... only much more polished! And, 

of course, the game takes place underwater, 

so much of our inspiration comes from there. 

In particular, many of the creature designs 

are based on real-life animals. Nature comes 

up with weirder, crazier stuff than any human 

mind could. 

 

I read you are already planning your next 

project. Any hints as to what it is about? 

 

ALEC: We have a grab bag of ideas germi-

nating. So far there seem to be three good 

candidates ... not sure which one we’re going 

to pick yet! We probably won’t be able to 

work on them for a while ...

 

When you entered IGF with Aquaria, what 

were your expectations? 

 

ALEC: When we first entered, we just hoped 

we’d get nominated for something. Any 

award. When we received 4 nominations, 

we thought, “Well, now we’d better win 

something!” 
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QUIRKY QUOTES
Favourite Console? 
 
ALEC: Currently Nintendo DS! But 

in terms of all time, probably Super 

Nintendo. 

 

DEREK: I think the NES holds the 

softest spot in my heart. But it’s like 

choosing between children... I don’t 

want to play favorites. I love them all.

 
Pizza or Pasta? 
 
ALEC: Tacos. 

 

DEREK: Pizza Pasta. 

Mars or Jupiter? 
 
ALEC: Uranus 

 

DEREK: Mars. I have three words for 

you: three-breasted prostitutes. 

Master Chief or Mario?  
 
ALEC: I’d love to see Mario crush Mas-

ter Chief’s skull in. 

 

DEREK: Whichever one can defeat King 

Koopa.

DEREK: Haha, yeah! It’s hard to know what to 

expect. Part of you wants to win, but you’re 

afraid of jinxing things. We were incredibly 

happy just to be able to attend, to be honest 

What do you think about the indie scene of 

today? 

 

ALEC: It’s exciting! 

 

DEREK: It’s getting bigger and better, but it 

still stays personal – I love that. I can tell 

you, two years ago, you really had to look 

hard to find good independent games. These 

days, it seems like everyone is interested. It’s 

wonderful. There’s really nothing more to say 

other than that it’s a great scene to be in. 

 

Where do you see the indie scene going?  

 

ALEC: I’d hope to see more power in the 

hands of developers. I’d like to see indie 

developers collaborate to create their own 

publishing label. 

 

DEREK: I feel like the independent scene 

is more flexible ... with that flexibility are 

going to come more unique opportunities. 

What we don’t have is the kind of power and 

money the mainstream industry has, so we’ll 

have to make up for it by sticking close and 

helping each other out. An indie-owned pub-

lishing label that’s not a casual portal would 

be wonderful. 

What is your advice for indie developers? 

 

ALEC: Keep your stick on the ice. If this is 

really what you want to do, keep at it until 

you succeed! 

 

DEREK: Work at it. Finish games, even if they 

aren’t perfect. Don’t sell your first finished 

game. Work with people who share your vi-

sion and dedication. Love what you do!  

Anything else you want to say? 

 

ALEC: I was hoping you’d ask “Why are you 

guys so sexy?” to which my answer would be 

“Aww, yeah.” Oh well. 

 

DEREK: I was tempted to answer “Aww, yeah” 

to every one of your questions, actually!

DB SAYS ...

I’ve already had a shot at the demo, and boy is this game 

sweet! Expect a proper review as soon as we get our hands 

on the full version. If you want to try it out yourself, visit Bit 

Blot’s website at http://www.bit-blot.com/
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by Gareth “Gazza_N” Wilcock

“Hey guys! I’m new to game develop-

ment, but I’ve got an awesome idea 

for a game that I wanna share with 

you. I hope to have it finished in like a couple 

of months, and it’s gonna be awesome. Here 

it is: I’m gonna make an MMO with like a mil-

lion items that you can combine for different 

effects, and huge randomly-generated areas 

populated with randomly-generated monsters 

with randomly-generated attacks, and, like, 

you can make your own spells, and the story! 

Man, the story’s gonna be awesome – it’s 

got  aliens and orcs in it. And, like, I know 

I’m new to this, so the graphics won’t be too 

complicated – just like Quake 1 graphics. So 

wadda ya think?”

What do I think? Oooooooh boy...

Now, I’m hardly the Most Enlightened Guru 

of Game Design, but the urge to squash the 

above with a snappy “there’s not one iota 

of the possibility of a chance that you will 

pull that off” reaches epic proportions. Let’s 

be blunt – the poor person has absolutely no 

idea what they’re getting themselves into, do 

they? They’ll flounder around hopelessly with 

all aspects of game creation before giving up 

and doing something simpler and more re-

warding, like raiding the liquor cabinet. Bet-

ter to put them out of their misery straight 

away, right? I’ll get the flamethrower. Let’s 

put that poor delusional n00b in their place.

Not so fast ... I’m pretty sure that many, if 

not most, of the people reading this article 

started devving (or are considering it) with 

the aim of creating exactly the kind of epic 

game described above. I know I did, and 

many people that I speak to who are inter-

ested in starting development give me very 

similar ideas. Yet, when I punted my big ol’ 

idea at Game.Dev a year ago, nobody shot 

me down. Nobody said “dude, don’t even 

bother, you have no idea what you’re doing”. 

They would’ve been right too. Yet, somehow, 

I’m still making games. Occasionally they’re 

even enjoyable. And my fellow newbies and 

I just so happen to be getting better and 

better despite our initial n00bitude. Imagine 

that.

My point - the vision is what’s important 

here. Those with the drive and passion to 

make games will work past the initial disap-

pointment and start working towards their 

grand ideas, learning and improving as they 

go. Those who aren’t willing to put the ef-

fort in (or who just aren’t suited to it) will 

crash and burn. It’s like that with any human 

endeavour. Slagging newbies, like I’ve seen 

done in some of the more elitist online com-

munities, does nothing for their confidence. 

It certainly isn’t helping them in any way, 

and it discourages someone who could poten-

tially be the next great design legend from 

ever getting started. Nice moves.

After all, I wonder how Will Wright’s critics 

feel now...





CARTESIAN CHAOS
http://www.retrotoast.com/
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by James “NightTimeHornets” Etherington-Smith

Cartesian Chaos, version 1.0, is the 

first commercial release from South 

African developers RetroToast 

studios, the winners of Game.Dev Comp 15. 

Regular readers of DEV.MAG may be familiar 

with their work, having been featured in the 

October 2007 edition. 

Cartesian Chaos is a challenging educational 

title that tests one’s mathematical prowess 

while being fun at the same time. The story: 

once every millennium, spiteful mathemati-

cal ‘expressions’ migrate across the Cartesian 

plane seeking to throw themselves back into 

the origin and end their tortured existence. 

This cannot be allowed to happen or else the 

basis of mathematical reality will be torn 

asunder. Never before has the world been 

so close to dividing by zero. All is not lost 

however, for each expression has a weak spot 

which can be targeted to destroy it and this 

is where the player steps in — to take the 

fate of the universe into their hands.

The game world is graphically simple yet 

polished and crisp, presenting a colourful 

Cartesian plane which will be familiar to 

anyone who has entered the first year of 

high school. A scoreboard and control panel 

keeps track of the current game on one 

side of the screen. The spiteful expressions, 

or monsters, appear from the sides of the 

screen and drift towards the center of the 

Cartesian plane, the origin. A wide variety 

of cartoon faces with expressions such as 

angry, confounded, happy, sad or frightened 

will assault from all angles. The faces also 

bear a mathematical expression above them, 

their weak spot, and this all makes for a 

nifty pun. Once a monster’s weakness has 

been uncovered it will be destroyed with a 

satisfying bolt of lightning and a comical wail 

which encourages the speedy dispatch of the 

next assailant. The musical soundtrack helps 

set a pace to the gameplay and offers enough 

variety to avoid becoming overbearing. 

The game provides three game modes: 

‘Quick Quadrants’ has you identifying which 

of the four Cartesian quadrants contains the 

monster’s weakness, and ‘What’s the Point?’ 

requires you to pinpoint the (x, y) coordinate 

of the weakness; ‘Define the Line’ is the most 

challenging and requires the solving of a line 

formula in the format of Y = MX + B in order 

to plot the gradient of the line. Simple and 

mostly effective tutorials are provided for 

each of these modes to ensure that the gam-

er doesn’t have to take a refresher course in 

mathematics from their 10 year old cousin. 

The more complex line equations can become 

slightly confusing, especially if one hasn’t 

practiced solving such formula recently and 

the tutorial on this could do with an added 

dose of clarity, something which is sure to be 

addressed in future updates. 

Along with the reflexes of a mathematically 

adept puma, the player also has a number of 

weapons at their disposal. These are awarded 

in the form of ‘powerups’ during the game 

and provide much-needed assistance. Five 

powerups in total allow the player to hinder 

the spiteful expressions’ progress and even 

reveal the locations of their weak spots. All 

is fair in math and war. Descartes himself had 

developed a devastating weapon named the 

Descartes Doomsday Device, better known as 

the DDD. With enough kills under the belt, 

the DDD becomes available and this bad boy 

has the power to zap every monster currently 

on screen. It comes with a warning however, 

“Do not push this button.” Scary stuff.
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The game can be played in 

either ‘Arcade’ or ‘Challenges’ 

mode and at four difficulty 

levels; easy, medium, hard and 

the aptly-named crazy. Arcade, 

as one would expect, has the 

player striving to set a personal 

best score. In Challenges, 48 

scenarios are offered and have 

the player attempting to beat certain scores 

or time limits, reach the target number of 

kills or deliver a certain number of combos. A 

combo is achieved by zapping 5 monsters in a 

row without missing and then continuing the 

streak. A speed combo is achieved by zapping 

monsters quickly.  Multiple player profiles can 

be used within the game and this allows for 

competition amongst friends and family to 

rank highest on the scoreboard.

There are minor gripes such as the inability 

to disable sound or music from within the 

actual game, being forced to return to the 

main menu to do so. This is further com-

pounded by the fact that one cannot leave a 

game to be resumed later. This could prove 

especially annoying in arcade mode when try-

ing to achieve a high score. The option to run 

the game in windowed mode seems largely 

redundant as the game is forced to run at 

1024x768 and using any desktop resolution 

lower than this will result in a windowed 

game that does not fit the screen at all. The 

only perceivable reason to use this would be 

the availability of the minimize button, for 

those who haven’t quite mastered alt+tab, 

to use in case the boss is about to catch you 

slacking off again.

The Quick Quadrants mode is by far the 

simplest, with only four possible solutions 

to any expression, but would still prove 

useful in teaching mathematical concepts 

to a child. Older players may quickly realise 

the loophole in this game mode as there is 

no real punishment for an incorrect answer, 

other than a loss of combo score, thus reduc-

ing the game to a frenzied click fest in order 

to beat the challenges. This is especially true 

on the higher difficulty levels in which the 

monsters assault the origin so quickly that 

there is no time to contemplate the correct 

answer. What’s the Point 

and Define the Line modes require 

more thought, often proving 

challenging and even downright 

impossible on the ‘crazy’ difficulty. 

Define the Line is no doubt aimed 

at those who have at least covered 

these concepts in school but in 

no way precludes younger players 

from learning. The equations require a sharp 

mind to calculate speedily and will provide 

a daunting test of one’s ability on the higher 

difficulty levels.

Cartesian Chaos is a terrific little package 

that injects some new ingredients into math, 

namely colour and fun, and gives an original 

and refreshing spin to puzzle games. Children 

will find themselves learning basic math-

ematical concepts in the guise of a fun-filled 

game and teenagers and adults will find plen-

ty of challenge in honing their math skills. 

Math is an area poorly explored by electronic 

games and Cartesian Chaos will really give 

the left hemisphere a solid workout.

DB SAYS ...

Want to try this game out for free? Find a demo of Car-

tesian Chaos at http://www.retrotoast.com/

The full version is available from Savage Software at 

http://savagesoftware.com.au/, and the product link is 

also available on Retrotoast’s home page.



3D Logic
http://www.kongregate.com/
games/AlexMatveev/3d-logic
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by Claudio “Chippit” de Sa

It’s uncommon to find a puzzle game that 

isn’t simply a tried and tested idea with 

a simple twist. In fact, more often than 

not, that’s all a puzzle game needs. 3D Logic, 

however, is a little more than a simple twist 

on an old idea.

The premise of the game is quite simple, as 

is often the case with successful puzzlers. 

You are presented with a grid of varying sizes 

and are required to connect special coloured 

squares with their counterparts by filling 

open blocks on the grid with a matching col-

our. The twist here is that field of play itself 

is mapped onto three faces of a cube.

The addition of an extra dimension adds a 

deceptive amount of challenge to what would 

otherwise be a rather simple game. But 

anyone persistent enough to complete all 30 

devilishly tricky levels will be awarded with 

the simple pleasure of a tangible feeling of 

success together with the boasting rights that 

it earns. 

3D Logic 2
http://www.kongregate.com/

games/AlexMatveev/3d-logic-2-
stronghold-of-sage
by Claudio “Chippit” de Sa

3D Logic 2 takes the gameplay tested 

in the first incarnation and gives it a 

good new coat of paint, some polish 

and 30 new, even more menacing, levels.

While the sequel doesn’t actually add any 

new gameplay elements to the game besides 

a relatively redundant ‘story mode’, it is 

rather selfish to ask for more than what it 

has already done. With a smooth new look, 

more intuitive controls and more high-quality 

levels, 3D Logic 2 does all it needs to do.

With its new skin to keep things fresh and the 

new controls that make it easier than ever to 

get every line connected, this sequel takes 

everything that was good about the first 

game and simply gives us more of it. If you 

ever feel masochistic, remember this game; 

it’s a perfect way to break your head.



nhancements to the games that you 

develop can take many forms. One 

enhancement that adds real spice is 

in-game movies. Blender 3D is an excellent 

free tool to help you produce short motion 

clips in almost any format. This tutorial will 

focus on some basic aspects of animation 

that I hope will assist you in creating 

animations that will enhance your game 

development.

Animation involves moving pictures. To make 

the moving pictures, we move things around, 

photograph them and then play the 

photographs back to make it look like they 

moved. Getting things to move is easy. But 

simply telling an object to move does not 

define the detail of the movement. Take a 

ball, for example. You can position the ball 

to fall to the ground, bounce and continue 

like this until it comes to a stop. The detail 

of the bounce is 

that the ball has 

zero speed at the 

highest point of its 

bounce, and the 

fastest speed just 

before it hits the 

ground. Where do 

this ani-

mation the 

camera will be 

doing a slow pan onto 

the planet from right to left. 

The planet will fill two thirds of the 

screen, indicating that we are quite 

close to it. At the end of the shot the 

planet will fill almost the entire screen. Then 

the satellite will fly in from the right, going 

towards the left. Without the satellite, the 

shot could simply be a documentary about a 

planet. The satellite flying past indicates 

some contact by humans with the planet. 

This could mean simple interest, monitoring 

of the surface, or many other things. The 

point is that it brings another emotion into 

the scene.

I have decided to animate the sequence as 

below, based on my storyboards.
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you tell the bouncing ball to change its 

speed? Or consider a rocket taking off. You 

may place the rocket on the ground, and 

then higher up in the air, but nowhere can 

you define how fast it accelerates. I'll use 

this tutorial to tell you how to define that 

movement.

Storyboarding the animation is quite 

important. It is necessary to know how much 

time we have, as well as how to pose the 

objects as cinematically as possible. This is 

where you have the opportunity to play film 

director. You call the shots.

I am going to use a planet, a satellite, and a 

camera. We will animate them separately 

from each other. The .blend file with all the 

elements will be provided, so that you can 

focus on learning the animation aspects 

quickly. The planet will be my main actor. In 



Begin this tutorial with the Blender file that 

is available from the website.

(http://www.devmag.org.za/uploads/

BlenderSatelliteStart.blend) 

You will see two viewports. The one on the 

left is the active camera view, which also 

represents the final rendered image view. On 

the right is a top view of the scene.

The Planetary rotation

I'm going to guess that you will also be too 

lazy to work out the rotation for the planet 

in a scientific way. Certainly your viewer/

player will be less concerned with the 

correctness of your planetary rotation than 

with its appearance. Therefore, I'll make a 

suggestion for the rotation values. You can 

change it any way that you like.

Select (RMB) the sphere representing the 

planet. With your mouse cursor over the top 

view, press [N]. You should see the object 

properties displayed like this (The property 

dialog will appear centered on your mouse 

cursor position):

Please note that all rotation values are 

currently zero. We will animate the RotZ 

value. Remember that, in Blender, you use 

the arrow keys to advance through frames. 

Up and Down advances or rewinds 10 frames 

at a time, while left and right moves one 

frame at a time. Once you are certain that 

you are on frame 1, press [I] and choose Rot 

from the list to insert a keyframe for the 

rotation value that the planet will have on 

this frame. Advance to frame 225. That will 

be the last frame of our animated sequence. 

Enter a value of 

10.00 next to RotZ. Insert another Rot 

keyframe.

Now change your bottom window to an “IPO 

Curve Editor” by clicking on the top left icon 

and choosing IPO Curve Editor from the list. 

Use the ‘zoom view to area’ icon to zoom in 

on the selected keyframes. This IPO curve 

represents acceleration. If you feel 

challenged by or scared of this screen, my 

suggestion is that you take a deep breath and 

hang tough.

On the horizontal axis we have time, and on 

the vertical axis the value that has been 

keyframed. In this case, we are seeing the 

rotation keyframed over time. As such, it is 

obvious that there is a slow start to the 

rotation, followed by a steeper acceleration 

curve, ending in a slowing down of the 

rotation.

This means that the planet will start rotating 

slowly, then speed up, and then slow down 

again. This is definitely not good behaviour 

for a planet, so we are going to change that. 

The way in which we will change it, will be 

by giving the curve a 

uniform acceleration.

Select the curve 

representing the Z-

rotation. Press [TAB] to 

enter edit mode for the 

IPO curve. Press [A] 

until both keyframes 

turn yellow (indicating 

that they have been 

selected). Blender 

provides three different 
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types of handles or controls for defining the 

shape of a curve. In this case we will use the 

Vector handle type to straighten our IPO 

curve.

Hit [V] and see the handles change to green, 

and the line is immediately straight. Now we 

have a constant rotation throughout. The 

planet will spin at a steady pace right from 

the start of the animation until the end. Hit 

[TAB] again to exit edit mode.

The Camera Movement

RMB select the camera. Insert a LocRotScale 

keyframe at frame 1. Now advance to frame 

225 and position the camera as in this image. 

Then insert another LocRotScale keyframe.

Since the camera represents a subjective 

view of the scene, we can accept any kind of 

motion. My suggestion would be to have the 

camera stationary for a few frames before 

the movement starts, and then again let the 

movement end a few frames before the end 

of the animation. We can do this by editing 

the curve and calling up the curve point 

(keyframes) properties.

Straightened IPO Curve



Select the rotation curve and go into editing 

mode. Select the curve point on the left and 

press [N]. The Vertex X value represents the 

frame value of the keyframe, i.e. this is the 

frame at which this keyframe or curve point 

is activated. To advance the keyframe along 

the timeline, simply type a different value 

next to Vertex X. In this case, I would suggest 

a value of 10.

You will see that your keyframe has moved. 

Now select the other curve point or 

keyframe, and change the Vertex X-value to 

215. This gives us 10 frames before the 

camera animation starts, and makes the 

camera movement stop 10 frames before the 

end of the animation. That's it for the 

camera. Press [TAB] to exit edit mode in the 

IPO curve editor.

The satellite fly-by

We want to have the satellite always pointing 

straight at the planet, in order to create the 

illusion that the satellite is observing the 

planet. We can do this by have the satellite 

point at the planet. I have made sure that 

the planet and the satellite have the same 

local orientation by selecting each in turn 

and pressing [Ctrl]-[A]. That applied their 

orientation, rotation and scaling. 

Select the satellite then the planet. 

Press [Ctrl]-[T]. Select TrackTo Con-

straint. If you grab [G] the satellite now 

and move it around, it should auto-

matically rotate so that it always faces 

the planet.

According to the storyboard I created, I 

want the satellite to come into shot at 

frame 100, and leave the field of view 

at frame 150. Go to frame 

100. Position the satellite 

just out of camera view and 

insert a LocRot keyframe at 

that point. Now advance to 

frame 150 and position the 

satellite at the opposite side 

of the camera view, just out 

of view. Add another LocRot 

keyframe.

When you now use the arrow 

keys to advance forward and backwards 

through your ani-mation you will see the 

satellite fly by the planet. We did create a 

problem... The satellite now comes into view 

accidentally before and after it should. My 

suggestion is that you go to frame 99 and 

151, and in both cases move the satellite 

quite far out of shot and insert a keyframe at 

both points.

Considering that a satellite would move at a 

relatively constant speed, my suggestion 

would be that you edit the curves for the 

satellite animation, making them straight as 

well, indicating constant movement.

To sort out the starry background, I have set 

my background color to black, and activated 
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the “Stars” button under the “Shading” ([F5]) 

and “World” buttons.

To render the animation, I have set my 

render screen up as in the image below.

The way in which you use the rendered 

frames depends on your development 

platform. Blender has a built-in video editor 

that allows you to render sequences of 

rendered files as video, should you require it 

in that format.

I hope that you have learnt some valuable 

information that will aid you in your future 

game development!

Happy Blendin’

Changing the X-value of the IPO curve.

Render settings: .png filetype, 225 frames, RGB

Star settings



ou have learned how to create a basic 

vector sprite and it can be very useful 

in a game, it will enrich the game and 

make it fun to play and interesting, the only 

problem is that a static, non-animated sprite 

will not add the professional feel and polish 

needed to make a game really stand out, 

even a small amount of simple animation can 

create a wondrous feel to the game with 

minimum effort. In this tutorial you will learn 

the basics of creating simple animation in 

Photoshop. It is very simple and easy to 

perform.

Firstly, open the last Photoshop project file 

we worked with. The different views of the 

character should be 

sorted into groups. 

Select the front 

view group and 

duplicate it to a 

new project of 

suitable size, 

preferably a size 

that is similar to 

the character 

itself.

If you downloaded the file that I 

supplied last month, you will have 

to unlink the layers as I have 

linked them to keep the relevant 

parts of our character’s body 

sorted and grouped 

together without 

creating a separate 

group for each body 

part. Select all the 

layers by pressing Ctrl + 

click on layers, right-

click, select “unlink 

layers”.

The first movement we 

will create is a very 

simple one, walking. All 

characters need to walk, 

well at least most of them 

do.

You will need to see each 

frame of the animation, so 

you will need to make the 

animation window available. 

Click Windows>Animation, 

make sure there is a tick 

next to the “animation label” 

and make sure the animation 

window is visible.

The first frame in the animation window 

should be the current image. While the 

current frame is selected, click on the 

“duplicate selected frames” icon, this will 

duplicate the frame and make it available 

for manipulation.
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While the second frame is selected in the 

animations window, select the characters 

right foot and move it up slightly, to give the 

effect of taking a step forward.

Now click on the duplicate layer icon. In this 

frame we will set the image back to its 

original state by moving the character’s right 

foot back down to give the effect of the 

character completing his step.

Select the current frame and duplicate it 

once again, this time, we will move the 

character’s left foot slightly up to give the 

effect of taking a step with the left foot.

Click on the play button to view the 

animation. It’s animated but not animated 

enough; it looks like the character is just 

tapping his feet. We need his entire body to 

be affected every time he takes a step, so 

select the second frame where he lifts his 

right foot and select all the layers (Ctrl + 

click on layer) except the foot layers then 

link them (right click>Link layers).

While the layers are selected, click 

Edit>Transform>Rotate. Now rotate the 

character’s body slightly to the right by 

approximately 3 to 5 degrees. Now click on 

frame 3, click Edit>Transform>Rotate and 

rotate the selected layers slightly to the left 

by approximately 3 to 5 degrees.

Click the play button; if you performed the 

method correctly, you will see a really cool 

looking animation of our character walking 

forward. This animation can be used in a 

game to make it look really awesome and 

polished.

That’s the basics of animation in Photoshop; 

you can experiment with the other views of 

the character and create every movement 

needed using the skills learnt in the past 

tutorials. The most useful tools for creating 

movement animations are the tools in the 

transform drop down menu under the edit 

menu. You can create a range of effects 

using these tools. For colour animations you 

can manipulate the blending options of the 

different layers in different frames and 

produce some really cool effects such as a 

change of skin colour to green when eating a 

poisonous item and other similar effects.

Once you have completed your animation, 

select File>Edit in Image Ready. When the 

project is open in Image Ready along with 

the animation window select 

File>Export>Animation frames as files, now 

save and you will have the images ready to 

use in a game.

If you are using a library/engine that needs 

the animation in GIF format, you can save 

the frames as GIF files then use the free 

application called UnFREEz to create one 

animated GIF file. Just 

drag the images into 

the UnFREEz window 

and save as an 

animated GIF file.

If you are creating 

animations for games 

then stay away from 

the tween option in 

the animations 

window, this will really mess up the 

background transparency as it creates 

translucent images to optimise the 

animation. If you are creating animations for 

web sites then using the tween option 

shouldn’t be a problem at all.

That’s the basics you need to know to create 

your own animated sprites for your games. 

Experiment with whatever you can in 

Photoshop, it can only help.

Go on, start creating some awesome 

animations to make your games even more 

fun and exciting! 
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UnFREEz:

This application can be obtained from 
http://www.whitsoftdev.com/unfreez/



he game development revolution is 

here! Well, not really, but for those 

who feel like developing games in 

Python, Pygame is the next best thing since 

sliced bread. Pygame is a set of modules and 

add-ons based on the Simple Directmedia 

Layer (SDL) library for the Python interpreter 

and programming environment. Created by 

other enthusiast Python developers to help 

you create the perfect game with less effort, 

the library includes graphics, keyboard, 

mouse and sound 

handling, amongst 

others, and adds onto an 

already reasonably 

powerful but easy to 

learn programming 

language. As it says on 

the Pygame website, it 'takes the C++ out of 

game development'.

Advantages to 

Pygame

Being an add-on for 

Python means it is 

cross-platform, 

allowing development 

for Windows, Mac OS 

and Linux, with each 

platform having its own 

Pygame version. One 

thing to note, though, 

is that Pygame will not 

install on a higher than 

required version of the 

Python IDE; if it says 

Python 2.4, be certain 

that it is in fact 2.4 you 

are using otherwise it 

will simply tell you that 

no Python environment 

is installed. Once 

installed, Pygame is 

fully integrated into 

the programming 

environment and all of 

its classes and sub modules appear in the 

python dot menu (the menu that pops up 

when you put a full stop after an identifier) 

making them easily accessible after a simple 

import statement.

Pygame is well documented and there are 

many tutorials covering the basics of game 

development in Pygame. Several of these as 

well as full documentation can be found at 

http://www.pygame.org/docs/. There is 

even a book on beginner’s development in 

python and Pygame available for sale. 

Information on the book can also be found on 

the Pygame website. Regular competitions 

are also run by the folks at pygame.org 

where you can showcase your acquired 

Pygame development skills. Another 

interesting addition to Python that is worthy 

of interest is Panda 3d which is a C++ 3D 

library with a set of Python bindings. More 

information on that can be found at 

www.panda3d.org.

You can find the various downloads of 

Pygame at www.pygame.org, and the 

required python interpreter at 

www.python.org.
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Creating an effective GUI
A practical approach to the layout and design of graphical user interfaces for games

DESIGN

22DEV.MAG ISSUE 19

by Sven “Fuzzyspoon” Bergstrom

In this article I aim to share some ideas, 

experiences and even tips for creating 

the GUI your game really needs. By no 

means am I an expert, but I aim to share 

information I have picked up over the years 

about interface design, and in this article I 

will cover topics ranging from the main menu 

of your game, through to the game menu, 

right even across to the interface design of 

the HUD, the options menu as well as cross-

ing some points on window based design.

At one stage in my life, in one stage in my 

game development cycle I decided to make a 

menu for a game. I made a few logical deci-

sions – about what need to be there, what 

was too much information, how many options 

I would provide my user with and the like 

– but after all that, even after implement-

ing my “perfect menu design” I felt unhappy 

with it. I was no artist; I wasn’t really even 

a good programmer at the time. But I knew 

then that I didn’t understand why the menu 

wasn’t as cool as other games I had played, 

or even as cool as my abilities could create. 

So I went on a mission to understand how 

games made effective designs out of minimal 

components, and how immense games could 

use a single mouse driven menu for every-

thing that needed to be done. How an effec-

tive GUI can be created and implemented 

was deeper than I had expected, but it make 

or breaks a LOT of how your game affects the 

game play, the player and even your engine.

Main menu

The first point I’m going to shed light on is 

the main menu. Ooh, obvious choice, but 

hear this. Did you know that about half of 

what someone thinks about the game is the 

menu? What is the first thing they see? Most 

gamers would skip intro movies and head for 

the game itself to see what the rave is about, 

and they are faced with your menu. A cum-

bersome menu with too many commands can 

overwhelm a player quite easily; to the point 

where he may just quit instead (it happens). 

Too many options can distract a player from 

setting up the important options, causing (for 

example) a player starting a game with an 

awesome custom skin for his player, custom 

music, all the wonderful things your game 

offers in the main menu but then, the graph-

ics lag and jerk because he has vertical sync 

set to on and he doesn’t have the greatest 

PC. This causes an instant black mark on the 

game to the players mind, because he needs 

to go back to the menu and try FIND what he 

needed to set in the first place. Don’t get me 

wrong, I’m not telling you to stick too many 

options into the main menu, but look at what 

options you are using screen space for, and 

how much of the space is dedicated to what 

is relevant to starting the game.

On the other side of the field, I don’t think 

you can have a menu with too little. Without 

making a stupid thought come up, if you 

leave out the options menu, that’s too little. 

I’m referring to a menu with only what’s im-

portant, as well-placed items and easy-to-use 

interface that even if simplistic, is effective. 

As you may figure out, I am a minimalist 

when it comes to design, but I always notice 

that menus that grab my attention have 

had only a few items – and they are well-

executed. This is an obvious statement to 

most of us, but I see far too many games that 

have poor menus because they try overdo the 

“functionality : wow factor” ratio. I WANT 

developers to make kickass, random, sexy, 

animated, motional amazing unconventional 

menus, but the second that crosses over 

to making the menu a little bit silly on the 

functionality side, revert.

Let’s look at some well-known examples, 

even of recent games that are out to see how 

we can identify a good clean and functional 

menu. My first example will be the good 

straightforward menu example: Command 

and Conquer 3, Counter-strike, Quake, 

Unreal Tournament, and so on. They all have 
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animations, all have a simplistic design. They 

have no excessive animations which make 

you wait while it animates itself, it doesn’t 

make load times excessive and it keeps the 

eye candy at a reasonable level. A game like 

Transformers, on the other hand, has an 

excessive animation. It makes me wait while 

it makes the cube spin. Even though it’s not 

lagging it feels slow. The average gamer / 

user wants to be able to navigate fast regard-

less of how cool it is. Let’s say I have been 

playing GenericGameName: 2 for a few days 

and it’s the 10th time I am logging in. I doubt 

I would need to re-familiarise myself with 

the menu, and I doubt I will be gawking at 

the eye candy. I want to be able to PLAY the 

game, that’s why I am running it. The Chroni-

cles of Riddick: Escape From Butcher Bay had 

a cube menu and extensive animation, but its 

navigation is simple, fast and well-made.

As far as first impressions are concerned, a 

great menu and an OK game goes a lot fur-

ther in the mindset of a player than a good 

game with a poorly managed menu. Some 

tips for a main menu: it must be simple, 

fast and effective. Cliché at least, but logic 

supersedes the need for fun menus when it 

comes to functionality.

Options menu

This part of the GUI, I hear you ask? Sure, it’s 

the same theme, same graphics even. Well, 

if your options menu is not cumbersome, but 

has a lot of options, that’s OK. But if it has 

a lot of options scattered all over the place 

not grouped by any means, no descriptions 

of what sets what option, for example, FSAA 

will most likely make some unsuspecting non-

technical person put it on, which is horrific 

when it comes to lag in games, especially 

with full screen post-processing shaders like 

HDR and bloom. In turn this forces the player 

to now try beat the lag to get to undo an 

option, which would most likely need the 

graphics device to reset, in turn unloading 

and having to reload the game again, making 

it a huge pain in the jack to make a mistake. 

Eventually, players may feel it safer to turn 

all the options off and play with less features 

because of one badly described menu fea-

ture. This is in the general tips, so I won’t 

carry on with that point. 

An important thing to watch out for in the 

options (and elsewhere) is the use of combo 

boxes, check boxes and other such GUI items. 

Don’t get me wrong, I love the simplicity, 

but have you ever played a game where the 

options flick back and forth when you are 

moving your mouse wheel on another option, 

which (as has happened to me) could mean 

you are scrolling through the list of resolution 

options? Make each option you are “working 

with” highlighted if possible, this will help 

players understand that what happens is their 

mistake, not the game’s fault. Also, be sure 

to make the items properly functional. There 

are a lot of half-baked GUI types out there 

because they’re created inside a game en-

gine. If you notice a lot of games put all the 

main important options outside of the game, 

in the operating system before you play, mak-

ing sure you get to have a look at that first, 

where it’s not squashed by spacing and it’s 

not limited by the code of the programmer 

who is rushing to meet a deadline. This is a 

great solution to most game options problems 

and seems to work really well in my view.

HUD and other on-screen displays

Don’t you love choice? Sure, I didn’t always 

go into Quake and change the HUD colors and 

transparency to make it personalized, but 

what if I wanted to? If I’m describing a new 

game to a friend, I can’t describe the graph-

ics more than saying how great they might be 

but I can point out other, more specialised 

aspects, and one thing players love is choice. 

It may take a little longer to implement cus-

tomisability, but what if a particular player 

likes to play with their HUD almost invisible, 

because they don’t really care how much 

gold or mana they have at the moment? If 

I’m confronted with a HUD that is static and 

“in the way” of my playing, my view of the 

game is tarnished. The colors, the size, the 
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transparency ... they’re small things, but 

they can help a player enjoy a game more if 

they have the ability to make it personal and 

more to their liking. 

I know nobody reading this would be dumb 

enough to make a HUD over some part of the 

screen that might prevent a player finishing 

a task in the game, or seeing that last enemy 

setting up an ambush for them. But few easy 

logic points will still be mentioned:

 - A HUD should never block gameplay (take 

focus from the game) 

- A HUD is for information and feedback, 

don’t litter it with useless specs

- A HUD can be whatever you want it to be, 

but make it useful

On-screen displays often have the choice to 

be hidden. This is a great help and will most 

likely make the game easier for you as the 

creator and the player. Players, believe it 

or not, are critical, especially if there has 

been any tiny speck of hype or build-up to a 

release. The minute they get into the game 

they immediately look at it with the harshest 

of critics and think about what they might 

not like. Even if the graphics of the menu are 

simple and not fancy, even if they are badly 

implemented, if it works great, and looks ok, 

and doesn’t stop me from playing the game 

itself most players breeze past the menus 

and enjoy the game a lot more than if there 

was any hindrance to getting the game going.

General Tips

Always display necessary information in the 

game, the menus everywhere. “Undocu-

mented” options are cool for advanced users, 

but most likely will push a player to not play 

a game with the games full potential, or his 

machines ability.

KISS – Keep it simple, is it that hard? A GUI 

that is simple but effective beats an ad-

vanced 3D menu that makes it hard to get to 

the game I want to play.

In-game menus are really, really important. 

If I get drawn away from my game – let’s say 

my dog got its head stuck in the fan and is 

trying to flick the switch – I must be able to 

hit a key that will allow me to return to my 

game and know what was going on, as well as 

present me with game options and informa-

tion that I might find useful.

Besides having a clumsy dog, I must be able 

to get out of the game quickly. There must 

be a good way to quit in most parts of the 

GUI in my opinion, because if I want to quit it 

shouldn’t take me a really long time. Saving 

must be in the quit option if needed, or au-

tosave must be done if possible and enabled. 

I never want to feel like the game is the 

reason I was late for an appointment.

Conclusion

Some may think this is all general knowl-

edge, but I felt compelled to elaborate 

because some games frustrate me (no names 

mentioned) due to the lack of GUI logic. This 

is open for discussion, and I’m always keen 

to hear opinions. These are mine, and are 

limited, but I hope you found them useful.
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BRRRR!
A TOUCH OF WINTER FROM YOYO GAMES

by Rodain “Nandrew” Joubert

It was early November, and the finishing 

touches were being applied to Dev.Mag 

for the month. We made our final e-mail 

check before the release, and were confront-

ed with a little elf that had snuck into our 

mailbox. It bore news of a great competition 

with amazing prizes, held in the faraway 

realm which was ruled by the group known as 

Yoyo Games.

Romanticism aside, we were sufficiently 

interested in this news to add a quick post 

about it before finishing off Issue 18 and 

sending it out into the big bad world.

A month passed. Overcome by December 

laziness and looking for anything to do other 

than work, I remembered the message sent 

to me by the great Yoyo. Deciding that it 

would be an interesting venture (and a great 

seasonal addition to Dev.Mag) I set off to 

investigate the competition for myself. The 

theme? Winter. Santa Claus, penguins and 

snowmen were to greet me at every turn ...

Yoyo Games are the new driving force behind 

the distribution and showcasing of the rapid 

game development tool Game Maker. They’re 

still in the beta phase (as reflected by a few 

niggling issues on some of the site’s pages) 

but they’ve already secured a strong follow-

ing in the Game Maker community and their 

competition has attracted lots of very well-

made entries in just over a month.

The site operates in a simple yet effective 

manner, similar to many other online game 

portals. The twist comes in when you realise 

that the games you’re loading up are entirely 

Game Maker products, playable straight from 

your browser using a special plug-in supplied 

by Yoyo Games. At a glance, players can 

see a list of games, their descriptions, their 

relative popularity, and even player com-

ments and reviews to help other people get a 

perspective on the various titles.

Although the winter competition hasn’t yet 

finished, here’s a smattering of the entries 

to show you what people in this community 

produce when they get their development 

groove on ...
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GARDEN GNOME CARNAGE

Finally, the gnomes have their revenge against all those pesky elves who come stomping around 

every Christmas. Tie yourself to a skyscraper on wheels and make those elves fly! A delightfully 

humorous and incredibly well-executed arcade game, Garden Gnome carnage is a fine example 

of what can be done with simplicity in mind. Although the gameplay isn’t as deep as a full-scale 

MMORPG, the short, merry sessions that players have with this title are unforgettable. 

GGC has been polished well enough to shine. Players are motivated, the eye-candy 

is pleasing, sounds and combos are satisfying and the winter theme is most definitely 

there in full force. Throw in a few extra elements such as unlockable protips, a tower 

that you can disassemble brick by brick (throwing aforementioned bricks at the hap-

less elves) and some interesting appearances when your score goes up, and you have a 

game that does a great job of filling those five-minute voids between tasks.

WORMAGE

Now here’s a friendly little title. As its description 

goes, there’s no violence, no gore, just good ol’ 

worm management in an effort to help the little 

critters survive winter! Wormage works because, like 

GGC, it doesn’t promise the earth. Rather, it works 

on giving the player just a few features and makes 

sure that everything works well together. It also 

works well to promote objective-based gameplay as 

well as good old sandbox fun. The graphics are nice, 

the sound is adorable and it has the potential to oc-

cupy a fair amount of a player’s time.

FLYWRENCH

To be honest, Flywrench’s supposed back story seems to be the only half-hearted link to 

the competition’s winter theme that can really be found in the game. Still, it deserves a 

mention due to its interesting gameplay and stylistic use of retro graphics and sounds. The 

basic gameplay involves a small ... thing ... which moves about in 

several different ways. The catch is that each particular movement 

changes the object’s colour, allowing it to get through like-coloured 

obstacles without getting zapped. Play this game if you want an 

example of how really basic graphics and game mechanics can offer 

a player with something fun and interesting. Be warned, however, 

as the game is perhaps a little too difficult and will chase away less 

determined gamers.
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TWODASE

Now to change the genre to puzzler, and the number of dimensions to three. Game Maker has 

a somewhat dubious reputation for 3D. It can be done, but most efforts involve a simple walk-

around-and-shoot-generic-stuff mechanic which is praised and drooled over by developers who 

don’t stop to consider that the end result is about as fun and original as a raw 

turnip. Twodase is a game which not only showcases GM’s 3D capability, but puts 

it to use in a game which the author has actually shown a great deal of care in 

making. It’s slick, and it engages the player beyond simply clicking at bad stuff to 

make disappear. In Twodase, you guide your snowman across a multitude of levels, 

bouncing on a series of ice blocks which subsequently disappear and leave a gap 

through which clumsy players can fall. To complete a level, players need to jump 

on all the blocks in a way which allows them to do so without falling.

PENGUINS UNDER SIEGE 2

We wrap up this brief showcase with something that occupied my attention for perhaps 

the greatest amount of time. Penguins Under Siege 2 isn’t the perfect game, but it has a 

surprising amount of content, including a multiplayer mode and several skirmish maps. The 

game pits two rival penguins against one another, each combat-

ant’s goal being to destroy the other’s crystal. Both sides have 

strongholds which they upgrade to increase their income, research 

new technologies and create powerful offensive and defensive 

structures. For the most part, the game is quite well-balanced, 

and most potential problems seem to have been considered and 

eliminated by the author. This is a great example of a GM title 

which genuinely has a lot to offer.

DB SAYS ...

Weee-ooo! If you’re looking for some quick indie gaming this holiday season, you can do a lot worse than 

checking out the entries of the Yoyo Games winter competition. Fire up your web browser and go to 

http://www.yoyogames.com/gamemaker/competition01 to try the games suggested, or explore the 

site for yourself! Just remember to keep an open mind — the community is full of developers who are 

at various levels of experience, and if you find a game which you think needs to be improved, always 

offer the author some *constructive* feedback. As a good game developer, it’s best to take the good 

with the bad and learn from both!




